DATA MANAGEMENT
FOR BUSINESS INTELLIGENCE

Data Access: Files



Bl Architecture

Figure 1. Typical business intelligence architecture.
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Two issues

Where are my files?
Local file systems
Distributed file systems
Network protocols

Which format is file data in¢

Text
CSV, JSON

Business Intelligence Lab



Local file

system

/' root directory Path of a r’esource

® Windows:

/b3 /hone /usr
; /1lib
locsa ucb
libe.a
opehw
fHeEe libm.a 4
be 1s
ATl
share
smithi \\
N
L)
bin .
.login mayg
.cshrec
prog.f

shomessmithjsprog. f

Business Intelligence Lab

= C:\Program Files\Office\sample.doc

® Linux:

= /usr/home/r/ruggieri/sample.txt



Disk file systems [edit

Disk file systems are usually block-oriented. Files in ¢

Lo C q I fi I e S y S'I' e m ¢ ADFS — Acorn's Advanced Disc filing system, suc

« AdVFS - Advanced File System, designed by Digi
¢ AFS (Not to be confused with Andrew File Systen
e AFS - Ami File Safe, a commercial file system shi
¢ AosFS - File System used by the Oberon and A2
A logical abstraction of persistent mass memory ¢ AFS-AheOS File System, a 64.6it joumaled f
¢ BFS - the Boot File System used on System V rel

hierarchical view (tree of directories and files) « BFS — the Be File System used on BeOS, occasi

« Birfs - is a copy-on-write file system for Linux ann
’rypes Of resources (fl|e, direc’rory, pipe, Iink, speciq I) ¢ CBMFS — The filesystem used on most Commod:
¢ CNMDFS — A filesystem extension added to CBMF
o CP/M file system — Native filesystem used in the
se rvices (indexing, iournq |ing) ¢ DDFS — Data Domain File System, the data dedu

e DTFS — Desktop File System, featuring file compi

resource attributes (owner, rights, hard links)

« DOS 3.x - Original floppy operating system and fil
. o EAFS — Extended Acer Fast Filesystem, used on
SG m p I e fl Ie SYSfem: « Extent File System (EFS) — an older block filing s
Win dOWS ¢ ext — Extended file system, designed for Linux sy:
¢ ext2 — Second extended file system, designed for

m NTFS, FAT32 o ext3 — A journaled form of ext2.
o ext4 — A follow up for ext3 and also a journaled fil

LmUX ¢ ext3cow — A versioning file system form of ext3.

] EXT2, EXT3, JFS, XFS, RE|SERFS, FAT32 o FAT — File Allocation Table, used on DOS and Mi
« VFAT — Optional layer on Microsoft Windows
¢ FATX — A modified version of Microsoft Windc

¢ FFS (Amiga) — Fast File System, used on Amiga
Business Intelligence Lab » FFS —Fast File System, used on *BSD systems



Distributed file system
o

/ root directory

/b3 /homne /usr

j /1lib
loces ucb
libec.a
w
™ [ more libm.a F
be 1=
ATl
share T\

PC-smithj hyn
-you

prog.f
shomessmithjsprog
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Distributed file system

Acts as a client for a remote file access protocol

logical abstraction of remote persistent mass

memory
Distributed file systems (eaiy
See also: Comparison of distributed file syster
SCI m ple file SYSTem: Distributed file systems are also called network fil
Sqmbq (SMB) ¢ 9P, the Plan 9 from Bell Labs and Inferno disti
¢ Amazon S3
or Common Internet File System (CIFS) « Andrew File System (AFS) is scalable and loc.
. ¢ Apple Filing Protocol (AFP) from Apple Inc.. A
etwork File System (NFS
N Y ( ) ¢ DCE Distributed File System (DCE/DFS) from
Hadoop Distributed File Sys’rem (HDFS) » File Access Listener (FAL) is an implementatic
« Microsoft Office Groove shared workspace, us
« NetWare Core Protocol (NCP) from Novell is t
o Network File System (NFS) originally from Sui
Mount /unmount

Business Intelligence Lab

0S4000 Linked-OS provides distributed filesy:
Secure File System (SFS)

Self-certifying File System (SFS), a global net
Server Message Block (SMB) originally from ||
authentication.



Network protocols

Files accessed through explicit request/reply

A local copy has to be made before accessing data

Resource naming:
Uniform Resource Locator (URL)

scheme:/ /user:password@host:port/path

http: / /bob:bye @www.host.it:80 /home /idx.html
scheme = protocol name (http, https, ftp, file, jdbc, ...)
port = TCP/IP port number

Business Intelligence Lab



HTTP Protocol

HyperText Transfer Protocol
URL: http://user:pwd@www.di.unipi.it
State-less connections
Crypted variant: Secure HTTP (HTTPs)

Windows clients
Any browser
> wget

GNU http://www.gnu.org /software /wget/
W3C http://www.w3.org/Library

Linux clients
Any browser
> wget

Business Intelligence Lab



SCP Protocol

Secure Copy
> scp data.zip user@mylinux.unip.it:datacopy.zip
File copy from/to a remote account
File paths must be known in advance

Client

command line:
> scp/pscp > scp?2
Windows GUI

WinSCP hitp://winscp.sourceforge.net
SSH Secure Shell

Linux GUI
SCP: default

Business Intelligence Lab



Two issues

Where are my files?
Local file systems
Distributed file systems
Network protocols

Which format is file data in¢

Text
CSV, ARFF, JSON

Business Intelligence Lab



What is a file?

o1 File = sequence of bytes

67 |73 | 65 |79 | 10 |83 |10

Business Intelligence Lab



How bytes are mapped to chars?

Character set = alphabet of characters

Coding bytes by means of a character set
ASCIl, EBCDIC (1 byte per char)
UNICODE (1/2/4 bytes per char)

Business Intelligence Lab



American
Standard
Code for
Information
Interchange

CODE | CHAR | CODE | CHAR | CODE | CHAR | CODE | CHAR | CODE | CHAR
0 NUL 26 SUB 52 4 78 N 104 h
1 SOH 27 ESC 53 5 79 O 105 i
2 STX 28 FS 54 6 80 P 106 ]
3 ETX 20 GS 55 7 81 Q 107 k
4 EOT 30 RS 56 8 B2 R 108 1
5 ENQ 31 Us 57 9 83 S 109 m
6 ACK 32 SP 58 84 T 110 n
7 BEL 33 ! 59 H 85 u 111 Q
8 BS 24 * 60 < B6 i 112 P
9 HT 35 # 61 = 87 W 113 q
10 LF 36 3 62 > 88 X 114 I
11 ¥T 37 % 63 ? 80 T 115 s
12 FF 28 & 64 @ o0 Z 116 t
13 CR 30 65 A o1 [ 117 u
14 SO 40 ( 66 B 02 ! 118 ¥
15 SI 41 ) 67 C 93 ] 119 W
16 DLE 42 * 68 D 04 " 120 X
17 DC1 43 + 69 E 05 _ 121 ¥
18 DC2 44 ) 70 F 06 122 z
19 DC3 435 - 71 G o7 a 123 {
20 DC4 46 72 H 08 b 124 |
21 NAK 47 ! 73 I o9 c 125 }
22 STN 48 0 74 T 100 d 126 ~
23 ETB 49 1 75 K 101 € 127 DEL
24 CAN 50 2 76 L 102 f

25 EM 51 3 77 M 103 £

Business Intelligence Lab




Text file = filet+character set
B

o1 Text file = sequence di characters

Business Intelligence Lab



Viewing text files

By a text editor
Emacs, Nodepad++,TextPad, GEdit, Vi, etc.

“Carriage return” character
Start a new line

Coding
Unix: 1 char ASCII(0A) (‘\n’ in Java)
Windows: 2 chars ASCII(OD 0A) (“\r\n” in Java)
Mac: 1 char ASCIHI(OD) (‘\r’ in Java)
Conversions

> dos2unix
> unix2dos

Business Intelligence Lab



Text file = filet+character set
2

o1 Text file = sequence di lines

Business Intelligence Lab



Tabular data format

Row

Column
23 | Student
Luigi ROSSI 30 | Workman
Anna Verdi 50 Teacher
Rosa Neri 20 Student

Business Intelligence Lab




Representing tabular data in text files

Comma Separated Values (CSV)

A row per line
Column values in a line separated by a special character

Delimiters: comma, tab, space

Mario,Bianchi,23,Student
Luigi,Rossi,30,Workman
Anna,Verdi,50,Teacher
Rosa,Neri,20,Student

—

Business Intelligence Lab




Representing tabular data in text files

Fixed Length Values (I1.V)

A row per line

Column values occupy a fixed number of chars
Allow for random access to elements

Higher disk space requirements

Mario|Bianchi 23' Student
Luigi [Rossi | 300 Workman
Anna [Verdi |50] Teacher
Rosa |Neri 20| Student

—

Business Intelligence Lab




Quoting

What happens in CSV if a delimiter is part of a value?

Format error

Solution: quoting

Special delimiters for start and end of a value (ex. “ ... “)

Mario Bianchi 23 Student

Luigi Rossi 30 Workman “Mario Bianchi” 23 Student
Anna Verdi 50 Teacher “Luigi Rossi” 30 Workman
Rosa Neri 20 Student “Anna Verdi” 50 Teacher

“Rosa Neri” 20 Student

-

Business Intelligence Lab
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Missing values

How to represent missing values in CSV or FLV?

A reserved string: “?”, “null”, “”

“Mario Bianchi” 23 Student
“Luigi Rossi” 30 ?

“Anna Verdi’ 50 Teacher
“Rosa Neri” ? Student

—

Business Intelligence Lab



Meta-data

Describe properties of data

Table name, column name, column type, ...

name | surname | age | occupation
string | string int string
Mario | Bianchi | 23 Student
Luigi Rossi 30 | Workman
Anna Verdi 50 Teacher
Rosa Neri 20 Student

Business Intelligence Lab




How to represent meta-data in text files?

1 One or two rows: names and types

name

surname

age

occupation

string

string

int

string

Business Intelligence Lab

name,surname,age,occupation
string,string,int,string

T



Meta-data and data in text files

In the same file
Meta-data first (header), then data

name | surname age occupation

name,surname,age,occupation

stri tri int stri
ng | string n "9 string,string,int,string

Mario Bianchi 23 Student Mario,Bianchi,23,Studente

Luigi,Rossi,30,0peraio

Luigi Rossi 30 Workman .
J Anna,Verdi,50,Insegnante

Anna Verdi 50 Insegnante Rosa,Neri,20,Studente

Rosa Neri 20 Studente — /

Business Intelligence Lab



Two issues

Where are my files?
Local file systems
Distributed file systems
Network protocols

Which format is file data in¢

Text
CSV, JSON

Business Intelligence Lab



Data interchange issue

Problem: data interchange between applications

Proprietary data format do not allow for easy interchange
CSV with different delimiters, or column orders

Similar limitations of FLV, ARFF, binary dataq, etc.

Solution:

definition of an interchange format...
. marking data elements with their meaning ...

... so that any other party can easily interpret them.

Business Intelligence Lab



DATA MANAGEMENT
FOR BUSINESS INTELLIGENCE

Data Access: Relational Data Bases

Computer Science Department, University of Pisa



Bl Architecture

Figure 1. Typical business intelligence architecture.
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Connecting to a RDBMS

Connection protocol Client Server
locate the RDBMS server ConnectionString >
open a connection <
user autentication OK

Querying SQL. query
query SQL g

SELECT
UPDATE /INSERT /CREATE
stored procedures
prepared query SQL
Result set

Scan Result set N
scan row by row
access result meta-data

\ 4 v

Business Intelligence Lab



Connection Standards

ODBC - Open DataBase Connectivity
Windows: odbc Linux: unixodbc, iodbc
Tabular Data

JDBC

Java APIs for tabular data

OLE DB (Microsoft)

Tabular data, XML, multi-dimensional data

ADO (Microsoft)
Obiject-oriented API on top of OLE DB

ADO.NET
Evolution of ADO in the .NET framework




ODBC Open DataBase Connectivity

- Local Machine
==

l Application l

l*

ODB C Driver Manager

| | | |
ODBC ODBC ODBC ODBC
Driver Driver Driver Driver

T

Local Local Remote
Database Database Database Database

Business Intelligence Lab



DATA MANAGEMENT
FOR BUSINESS INTELLIGENCE

ETL — Extract, Transform and Load

Computer Science Department, University of Pisa



Bl Architecture

Figure 1. Typical business intelligence architecture.
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Extract, Transform and Load

ST (extract transform and load) is the process of
extracting, transforming and loading data from
heterogeneous sources in a data base /warehouse.

Typically supported by (visual) tools.

No. List of ETL Tools Version ETL Vendors

1. Oracle Warehouse Builder (OWB) 11gR1 Oracle

2. Data Services XI 3.2  SAP Business Objects new!
3. IBM Information Server (Datastage) 3.1 IBM

4, SAS Data Integration Studio 4.21 SAS Institute new!

5. PowerCenter 3.0 Informatica

6. Elixir Repertoire 7.2.2 Elixir

7. Data Migrator 7.7 Information Builders new!
8. SQL Server Integration Services 10 Microsoft

9. Talend Open Studio & Integration Suite 4.0 Talend

10. DataFlow Manager 6.5 Pitney Bowes Business Insight
11. Data Integrator 9.2 Pervasive

12. Open Text Integration Center 7.1 Open Text

13. Transformation Manager 4.1.4 ETL Solutions Ltd.

14, Data Manager/Decision Stream 8.2 1BM (Cognos)

15. Clover ETL 2.9.2 Javlin

16. Centerprise 5.0 Astera new!

17. DB2 Warehouse Edition 9.1 1BM

18. Pentaho Data Integration 4.1 Pentaho

19 Adeptia Integration Suite 5.1 Adeptia



ETL tasks

Extra(:t: access data sources
Local, distributed, file format, connectivity standards

Transtorm: data manipulation for quality improvm

Selecting data

remove unnecessary, duplicated, corrupted, out of limits (ex.,
age=999) rows and columns, sampling, dimensionality reduction

Missing data
fill with default, average, filter out

Coding and normalizing

to resolve format (ex., CSV, ARFF), measurement units (ex., meters vs
inches), codes (ex., person id), times and dates, min-max norm, ...

Attribute Splitting /merging

of attributes (ex., address vs street+city+country)

Business Intelligence Lab



ETL tasks

Managing surrogate key & Slowly changing dimensions
generation and lookup

Aggregating data

At a different granularity. Ex., grain “orders” (id, qty, price) vs

grain®“customer” (id, no. orders, amount), discretization into bins, ...

Deriving calculated attributes
Ex., margin = sales — costs

Resolving inconsistencies — record linkage

Ex., Dip. Informatica Via Buonarroti 2 is (2) Dip. Informatica Largo B.
Pontecorvo 3

Data merging-purging
from two or more sources (ex., sales database, stock database)

Business Intelligence Lab



ETL tasks

l.oad

Data staging area
Area containing intermediate, temporary, partially processed data

Types of loading:

Initial load (of the datawarehouse)

Incremental load
Types of updates: append, destructive merge, constructive merge

Full refresh

Business Intelligence Lab



ETL process for DW
R

Control Flow

Update Dim1

Update Dim2

Prepare Update fact
Update Dim3

Update Dim4

Business Intelligence Lab



BUSINESS INTELLIGENCE

SSIS - SQL Server Integration Services



Background

SSIS is a tool for ETL

It can be used independently from SQL Server

Formerly called Data Transformation Services (in SQL

Server 2000)

Docs and samples

Tutorial from Books on Line
http: //msdn.microsoft.com/en-us/library /ms141026.aspx

CodePlex samples

http: / /www.codeplex.com/SqlServerSamples#ssis

On-line community
http://sqlis.com

Business Intelligence Lab



Developing SSIS projects

Developer framework
Integrated within SSDT/BIDS

Solution = collection of projects
Project = developer project (C++, C#, IS, ...)
Demo
File > New Project - Integration Services
Panels: solution explorer, server explorer, others

SSIS packages (.dtsx extension)

Panels: control flow, data flow

Business Intelligence Lab



Control flow / Jobs

Tasks, Containers & Precedence

Tasks
ETL tasks (list in the Toolbox panel)

Container |
Package
lteration
| Task | [ Task |
Precedence
Precendence | l_,
Arrows connecting tasks specify Constraint .
dence type Container
rece
i ! Task
| Task I | Task |
| Task |

Business Intelligence Lab




Data flow / Transformations

1 Special tasks 1 0

File Database

-1 Define pipelines of data flows Elxtema'“'“mns

from sources to destination S

Input Columns

Data flow sources Output Conumnsl ET| e
. Destination
Data flow transformation III I @
Input

Input Columns

Data destination

Transformation
Input Columns

TOOI bOX p a nel for IiS‘I' Output Columns Output || Error Output

InputColumns’ Input ‘

Destination

Input Columns
Error Output I

Business Intelligence Lab



SSIS projects structure

m Custom Applications !

| Command Line Utilities I1
A

SSIS Designer
Integration

4 Service
Tasks | Natve |  Managed
Object Model ;
C%itfgn Integration Services Runtime -dtsx File
Package d;_
— Database
Log | v Contai ¥ Enumerators |
Providers 3 Task ner
Task Connection |
Managers
Data Tals . Ta=Sk Event
b vy Handlers
% % [ Data Flow Task
T

Data Flow Task
Object Model

Integration Services Data Flow

|  Source || Source |
vy v
Imnsformatlon |
Data Fl =
Co;\:on:r‘:vts | mn;fom:tlon I
Custom ’ | Destination | | Destination |
Data Flow
Components




SSIS data types

SSIS defines a set of reference data types
As seen for connectivity standards (ODBC, JDBC, OLE DB)

http:/ /msdn.microsoft.com/en-us/library/ms141036.aspx

Data type from sources are mapped into SSIS types
SSIS transformations works on SSIS types

SSIS types are mapped to destination data types

Business Intelligence Lab



Debug, deployment, scheduling

Debug

Data viewers

Deployment
Save project on file
Save project on remote SSIS server
Project->Deploy
Load project from remote SSIS server
File->Add new project->Integration Services Import Project Wizard

Launch

Local run
From Visual Studio
From command line: dtexec
From explorer: double click on .dtsx files

Remote run on SSIS servers
On demand / scheduled

Business Intelligence Lab



Change data capture
i

Capture
process

Change
tables

Change data capture
query functions

Business Intelligence Lab



BUSINESS INTELLIGENCE LABORATORY

ETL Demo: Pipeline, Sampling and
Surrogate Keys



Pipeline

Consider the Foodmart sales database

Design an ETL project for writing to a CSV file the
list of products ordered descending by gain

Gain of a single sale is defined as (store_sales —
store_cost)*unit_sales

Avg gain of a product is the sum of gains of sales of
the product divided by the total units_sales sold

Do not use views or queries! Do all work in ETL.

Business Intelligence Lab



SQL SOLUTION

SELECT product id
FROM Sales
GROUP BY product id

ORDER BY SUM(store sales-store cost)/
SUM(unit sales)

. and what about adding Product name?

Business Intelligence Lab




BASIC IDEA OF SISS SOLUTION

PROJECT product_id

E = suM(store sales-
store cost)/SUM(unit sales)

ORDER by E

Grouping by product and compu@—/

SALES

Business Intelligence Lab



Stratified subsampling

Consider the census table in the MasterBigData db

Design an ETL project for writing to a CSV a
random sampling of 30% stratified by sex

30% of males plus 30% of females

Do not use views or queries! Do all work in ETL.

Business Intelligence Lab



BUSINESS INTELLIGENCE LABORATORY

Lab exercise on ETL: SCD



SCD: background

Slowly Changing Dimensions
Datawarehouse dimensions members updates

Three types:
Type 1: overwrite previous value
Type 2: keep all previous values
Type 3: keep last N previous values (N ~ 1, 2, 3)
Each attribute of the dimension can have its own type
Type 1: name, surname, ...

Type 2: address, ...

Business Intelligence Lab



SCD: input and output tables

Database FoodMart in SQL Server
Input
table customer

Output in Lbi database

create a table customer dim

columns

surrogate_key (PK), customer_id, customer_name, address,
date_start, date_end

with
surrogate_key being a surrogate key, customer_name including

name and surname, address made of address1-city-zip-
province-country, date_start and date_end are dates



Preliminary step

Develop a SSIS package that adds to customer dim
the customers in cuslomer that are not already in it



SCD: type 1 updates

Overwrite previous value

Changes on the input table customer

On 10/3/2007
231, Mario Rosi, Via XXV Aprile Pisa

On 12/3/2007
231, Mario Rossi, Via XXV Aprile Pisa

Surname has been corrected

Business Intelligence Lab



SCD: type 1 updates

The DW customer dim table looks as:
On 10/3/2007, and up to 12/3/2007

surrogate_key, customer_id, name, address, date_start, date_end
874, 231, Mario Rosi, Via XXV Aprile Pisa, 10/3/2007, NULL

On 12/3/2007

surrogate_key, customer_id, name, address, date_start, date_end

874, 231, Mario Rossi, Via XXV Aprile Pisa, 10/3/2007, NULL

Business Intelligence Lab



SCD: type 2 updates

Keep all previous values

Changes on the input table customer

On 12/3/2007
231, Mario Rossi, Via XXV Aprile Pisa

On 25/9/2008

231, Mario Rossi, Via Risorgimento Pisa

Customer has changed his address

Business Intelligence Lab



SCD: type 2 updates

The DW customer dim table looks as:
On 12/3/2007, and up to 25/9/2008

surrogate_key, customer_id, name, address, date_start, date_end
874, 231, Mario Rossi, Via XXV Aprile Pisa, 10/3/2007, NULL

On 25/9/2008

surrogate_key, customer_id, name, address, date_start, date_end
874, 231, Mario Rossi, Via XXV Aprile Pisa, 10/3/2007, 25/9/2008
987, 231, Mario Rossi, Via Risorgimento Pisa, 25/9/2008, NULL

Business Intelligence Lab



Lab exercise

Design a SSIS project to update customer_dim
starting from customer as follows:

Customers in customer that are not in Cust()mer_dim
are added to it

Updates of customer_name are of Type 1

Updates of address are of Type 2

Business Intelligence Lab



Sales during travels

A sale in sales_fact was done during a travel if the store of the
sale was not in the city of residence of the customer. Develop a

SSIS package which produces a CSV file with a row for every
customer with:

the customer full name
the total sales to the customer

the ratio of sales done during travels

Business Intelligence Lab



Sales in weekends of previous month

For a given customer and month, the frequency of purchases in
weekends (FPW) is the number of distinct weekend days
(Saturdays or Sundays) of the previous month in which the
customer made a purchase. Develop a SSIS packagewhich
produces a CSV file with a row for every customer and month

with:
the customer full name
the month and year

the customer FPW

Business Intelligence Lab



